
#$K {bmc Pman.bmp} Introduction to Helix delta-Q 

Welcome to the Helix delta-Q version 2 Pump & Pipe Flow Analysis Program - an essential tool 
for engineers to quickly and easily optimise pipe networks for compressible and 
incompressible fluids.  

You can calculate friction losses and pressure drops in pipes and fittings for Liquids, Slurries 
and Gasses. Model complex process flow pipe networks and solve for unknown flow rates and 
node pressures at the press of a button. Retrieve data from user accessible databases for 
Liquids, Slurries, Gasses, Pumps, Pipes and Fittings.  

delta-Q version 2 is the fourth generation of Pump and Pipe Flow analysis software produced by 
Helix Technologies and is founded on many years of practical fluid flow system and software 
design experience by the company. 

Sketch your pipe and pump network by dragging and dropping icons onto the screen. Setup your 
pipe, pump and sprinkler details, press Solve, and the program will calculate flow rates and 
pressure drops in each branch of the network. 

 
You can have different fluids flowing in different pipes in the network to cater for process changes 
in the system - for example, you may have a concentrated slurry in one pipe flowing into a 
junction with a water pipe (or pipes) and dilute slurry flowing through the network from there 
onwards. Or a heat-exchanger in the system may raise the temperature and change the fluid 
properties - you only need to enter the altered properties in the downstream section and the 
network will be re-modeled. 

Answer What if? questions such as what if this pipe in the system has a closed valve in it, or 
becomes isolated from the system? What size orifice plate is required? 

You can incorporate as much or  as little detail as you require - if you are doing a quick feasibility 
calculation you can merely enter a total pipe length and an estimated total K value for fittings. 

                                                      
# IDH_QINTRO 
$ Helix delta Q: Introduction 
K Intro;Introduction 



Alternatively, if you are doing detailed design work you can model the system to include every 
single bend, valve and fitting with individual head losses calculated using the K and Kf methods. 

You can choose the method of calculation - the default is Darcy-Weisbach but you can set the 
program to calculate the network using Hazen Williams (to comply with NFPA standards, for 
example). For Slurries, the program handles both Heterogeneous settling type slurries as well 
as non-Newtonian fluids such as Bingham slurries. And you can have a combination of these in 
the same network! 

For Gas networks, the program lets you choose whether to use classic Isothermal gas flow 
theory or the Modified Darcy method where an expansion factor compensates for choked flow 
conditions. The program solves complex gas flow pipe networks at the touch of a button. This 
means that you can model almost any fluid flow situation which may be encountered in a large 
process environment, from water to solutions, slurries, steam, compressed air and process gas 
lines.  

A pipe capital versus operating cost model will help you make the correct decisions on pipe size 
versus pressure drop operating costs and result in a more cost effective plant design.  

Helix delta-Q is designed to assist engineers and process pipe system designers to produce 
technically and commercially sound designs in a very short time. 

The network diagram and system head curves can be printed and Design Reports are produced 
simply in a compact table format which can be printed or pasted into MS Excel, Lotus 1-2-3 or 
any other Windows compatible spreadsheet or word processor. Network results can be viewed in 
graph form too for easy interpretation. 

 



 
 
delta-Q will save you time and reduce your plant capital, maintenance and operating costs. 

 
 



# $ k {bmc Pman.bmp} System Requirements 
To run the Helix delta-Q version 2 program you need: 

• Personal computer with Pentium I or higher microprocessor. 
• 16 MB of RAM. 
• 4 Mb of Hard Disk space. 
• 3.5” 1.44 MB or CD ROM disk drive. 
• Microsoft Windows 95, 98 or NT 3.51 or later version. 
• 800 x 600 or better resolution VGA monitor. 
• Printers, plotters and networks supported by Windows 95 or later. 
• Microsoft mouse or compatible is recommended. 

                                                      
# IDH_QSYSREQ 
$ System Requirements 
k System Requirements;Hardware;Software;Installation 



# $ k {bmc Pman.bmp} Program Installation 
The program is supplied in one of the following file formats: 

A) 3 x 1.44 Mb 3.5” disks 
B) CD ROM disk. 
 

Floppy Disk Installation 
Insert Disk 1 in your A: drive.  

From the Microsoft Windows Desktop, Select the Start button and the Run menu option and type: 

a:\setup  or use the Browse button to locate the Setup.exe file.  
Press OK and the Setup program will start. Follow the on-screen prompts of the Setup Program 
which will guide you through the installation process. 

CD ROM Disk Installation 
Insert the CD ROM in your CD-ROM drive, usually designated D: drive. From the Microsoft 
Windows Desktop, Select the Start button and the Run menu option and select the browse 
button. change to your CD-ROM drive, then select the Delta_Q sub-directory and then select the 
Setup.EXE program. The Run window should look something like this : 

d:\delta_Q\setup 
Press OK and the Setup program will start. Follow the on-screen prompts of the Setup Program 
which will guide you through the installation process. 

 

Security Key (Dongle) Device Driver. (Full Version Only) 
Before you can run the Helix delta-Q program, you need to install a device driver for the Dongle. 
The dongle is a match box sized device which activates the Helix delta-Q software, and this 
device requires a Device Driver program to control it. 

After running Setup.exe, you must run the Hdd32.exe program to install this device driver. It is 
located on Disk 3. Run it by inserting the Disk marked number 3 in your A:\ drive. Then Select 
Start, Run from the Windows task bar and Run the Hdd32.exe program by following the on 
screen instructions. 

This program will install the Device Driver for the Dongle hardware lock device. You only need to 
run this program once to install the device driver. Refer to the Hdd.hlp file for more details. It is 
not necessary to copy the Hdd32.exe file to your computer Hard disk. 

Installing the Dongle: 

After installing the files described above, you need to install the Dongle on the parallel (LPT) port 
on your computer. This port is usually the one connected to your printer. Switch off your 
computer, remove the printer cable (if fitted) from the port, insert the dongle, tighten the screws 
and re-insert the printer cable (if fitted). Re-start the computer and run the Delta-Q program by 
selecting the Start, Programs, Helix delta-Q menu option. The Dongle will not affect the operation 
of the printer in any way. It is not necessary to have a printer coupled to the computer to use the 
software. The Dongle may be installed on any parallel port on the computer.  

 

#k To un-install the program follow this procedure: 
                                                      

# IDH_QINSTALL 
$ Program Installation 
k Installation;Un-Installing;Dongle;Device Driver;Hasp 



Select Start, Settings, Control Panel. Click on the Add / Remove Programs icon. A list of 
programs installed on your computer will be displayed. Select the Helix delta-Q program from the 
list and click the Add / Remove button. Confirm the removal and follow the instructions of the 
removal program. 

The Helix delta-Q program does not install any files except those listed in the Program Files, 
Helix, delta-Q sub-directory and these can be deleted after un-installing the program. 

                                                                                                                                                 
# IDH_QUNINSTALL 
k Un-Installing 
 



# $ k {bmc Pman.bmp} Using Help 

The program is provided with context sensitive on-line help for all functions and procedures. 
Simply press F1 and the help topic relating to the current subject will be displayed. Alternatively, 
use the Help main menu to access the Help Contents list and select the subject you require from 
the contents list, or use the Search for Help on... menu to search for a topic using keywords. A 
section on how to use the Help files is also provided under the Help menu. 

                                                      
# IDH_QUSINGHELP 
$ Using Help 
k Using Help;Help 



# $ k {bmc Pman.bmp} References 
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AND PIPE, Crane Co. 

PERRY’S CHEMICAL ENGINEERS HANDBOOK, 7th Ed, Robert H. Perry, Don W. Green 

PUMP HANDBOOK, Igor J. Karasik et al 

 

                                                      
#IDH_QREFERENCES 
$ References 
k References 



# $ k {bmc Pman.bmp} Viscosity 
The viscosity of a fluid is a measure of its resistance to flow due to the existence of internal 
friction. The co-efficient of dynamic viscosity is the force required to move a unit area of fluid a 
unit distance. 

Newton’s law of viscosity : R dv
dz

= −µ  
The shear stress R is proportional to the velocity gradient -dv/dz in the fluid. 

The constant of proportionality is known as the co-efficient of dynamic viscosity µ . 

Dynamic or Absolute Viscosity = Shear Stress / Shear Rate   and  
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# IDH_QVISC 
$ Viscosity  
k Liquids;Viscosity;Shear Stress;Shear Rate;u,Slurry 



# $ k {bmc Pman.bmp} Liquid Classifications 
Liquids may be classified into a number of categories depending on their behavior. 

The most common type is known as a Newtonian Liquid, in which the dynamic viscosity remains 
a constant at varying rates of shear. 

 
 
Note: The Bingham plastic requires a shear stress of some finite value before flow starts. This 
results in a relatively high friction loss even at very low flow rates. 

                                                      
# IDH_QLIQCLASS 
$ Liquid Classifications  
k Liquids;Viscosity;Shear Stress;Shear Rate;u,Slurry 



# $ k {bmc Pman.bmp} Reynolds Number Calculation 
Reynolds Number gives an indication of whether the motion of a fluid is laminar or turbulent. 
The distinction was made by Professor Osbourne Reynolds in a paper published in 1883. 
It is a dimensionless value, given by : 
 

  R VD
v

=  

 
 where : 
  R is Reynolds Number 
  V is the average velocity in m/s (ft/sec) 
  D is the pipe diameter in m (ft) 
  ν is the kinematic viscosity in m2/sec (ft2/sec) 
 
Note :  A Reynolds number of less than 2000 generally indicates that flow is laminar. From 2000 
to 4000 there is a transition zone and then above 4000 flow is considered to be turbulent. 
 
See Darcy Formula 
 

 

                                                      
# IDH_QREYNOLDS 
$ Reynolds Number  
k Liquids;Reynolds Number;Turbulent;Laminar 

Comment [PB1]:  



# $ k {bmc Pman.bmp} Hazen Williams Friction Loss Calculation 
The Hazen-Williams friction loss equation is one of the most widely used of a number of Empirical 
equations for friction loss calculations. It is only suitable for use on Water. 
in English units it is : 

H L
C D

Qf
HW

=
4 73

1 852 4 87
1 852.

. .
.  

 
where Hf   = head loss in ft 
 L = pipe length in ft 
 CHW = Hazen-Williams C factor 
 D = Pipe diameter in feet 
 Q = Flow rate in cubic feet per second 
 
 
The Hazen-Williams C factor depends on the smoothness of the pipe with values ranging from 
about 100 for rough pipes up about 150 for very smooth bore pipes. Typical values are 120 for 
new steel pipes and 140 for uPVC pipes. 
 
Note : There are two methods used for calculating fitting losses in this program. The first is the 
standard shock loss or velocity head method in which a K factor, which depends on the fitting, is 

multiplied by the velocity head i.e. Hf K V
g

=
2

2
. This method is the one which should be used for 

all fittings if the Hazen-Williams method is used. 
The other fitting loss calculation method uses a Kf factor and the velocity head. The Kf factor is 
multiplied by the Darcy friction factor to arrive at the K value, making the fitting loss vary as the 

friction factor changes (due to changes in fluid viscosity or turbulence). i.e. Hf f Kf V
g

= •
2

2
 

This method is not suitable for use when the Hazen-Williams calculation method is used. 

                                                      
# IDH_QHAZEN 
$ Hazen-Williams 
k Friction Loss - Hazen;Hazen-Williams;C Factor;Pipe Roughness;Fitting losses 



# $ k {bmc Pman.bmp} Darcy-Weisbach Friction Loss Theory 

THEORY AND CALCULATION BASIS USED IN THIS PROGRAM  
INTRODUCTION   
Many empirical formulae for the calculation of friction losses and estimation of flow have been 
developed over the years, beginning with Chezy in 1775, and including well known formulae by 
Manning, Bazin, Kutter and Hazen-Williams . 

However, as these are empirical formulae, they are based on limited test data and do not have a 
scientific physical basis, although they are readily calculated. It was only after Professor 
Osbourne Reynolds discovered in 1883 that there are two definite states of flow, one being 
Streamline or Laminar flow and the other Turbulent flow, that the physical basis of fluid friction 
became evident. Reynolds determined the non dimensional ratio R = VD/v now called    Reynolds 
Number. A value of R below 2000 is deemed to indicate a Streamline flow condition, and above R 
> 4000 is considered a Turbulent flow condition. 
 
In the 1930’s, Karman and Prandtl published theories and formulae which estimated a friction 
factor for smooth turbulence and for rough turbulence. Nikuradse performed experiments on 
determining roughness factors by using pipes roughened by uniform particle size sand grains 
stuck to the internal surfaces, and this led Colebrooke and White to study friction losses in    
commercial pipes. The equation derived by Colebrooke and White for determining the friction 
factor is now regarded as the most accurate method of determining friction losses in pipes, and is 
the one used in this program, in conjunction with the Darcy-Weisbach formula. 
 
Darcy formula      
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where : 

 Hf is the friction loss in m (ft) 
 f is the friction factor 
 R is Reynolds Number  
 ∈ is the Absolute Roughness in m (ft) 
 D is the pipe diameter in m (ft) 
 
See Also Fitting ‘k’ Value Calculation 
 
Refer to the Hazen-Williams method for an alternative for water friction loss calculations. 

                                                      
# IDH_QDARCY 
$ Darcy-Weisbach Friction Loss Theory 
k Darcy;Weisbach;Fanning;Friction Loss;Hf;f;Friction Factor;Colebrook;Hazen-
Williams;Moody 





# $ k {bmc Pman.bmp} Files and Data 
The Helix delta-Q program only installs files to the application subdirectory. The default location 
of the application subdirectory is : 
 
c:\Program Files\Helix\delta_Q2 
 
In addition to the files in this directory, the setup program also creates the following 
subdirectories: 
 
c:\Program Files\Helix\delta_Q2\Data\Liquids  Liquid data files 
c:\Program Files\Helix\delta_Q2\Data\Gasses  Gas data files 
c:\Program Files\Helix\delta_Q2\Data\Slurries  Slurry data files 
c:\Program Files\Helix\delta_Q2\Data\Pipes  Pipe data files 
c:\Program Files\Helix\delta_Q2\Data\Pumps  Pump data files 
 
These are data files and should be backed up when doing disk maintenance. 
 
The setup program also creates a data directory for storing Project design files: 
 
c:\Program Files\Helix\delta_Q2\Projects  Network data files 
 
Each network requires two files, the first being a file with an extension of .NWK which contains 
the node and pipe details and the second with an extension .NWI which contains the project 
details and design comments. If you are transferring network design files from one directory to the 
next, you must transfer both of these files. 
 
 
 
 

                                                      
# IDH_QFILES 
$ Data Files 
k Friction;Files;Data Files; 



# $ k {bmc Pman.bmp} Absolute Roughness  

The Absolute roughness of the inside of a pipe is used in the calculation of the friction factor in 
the Darcy-Weisbach Friction Loss Formula. 

When the Hazen-Williams method of friction loss is used, the program does not use the f factor 
but rather a C factor which usually ranges from about 100 for rough fouled cast iron pipes to 
about 150 for very smooth pipes with little flow disruption at the pipe joints. Refer to the Hazen-
Williams section for more details. 

 

METRIC TABLES. 
RECOMMENDED ROUGHNESS VALUES   Absolute roughness , k in mm 
( for use with Darcy - Weisbach formula ) 

CONDITION 
   PIPE MATERIAL                                     GOOD    NORMAL    POOR 
   (NEW & CLEAN UNLESS STATED)                        mm       mm       mm 
============================================================================ 
METAL 
Uncoated Steel ....................................   0.015     0.03    0.06 
Coated Steel ......................................   0.03      0.06    0.15 
Galvanized Iron ...................................   0.06      0.15    0.3 
Uncoated Cast Iron ................................   0.15      0.3     0.6 
Coated Cast Iron ..................................   0.06      0.15    0.3 
 
Old tuberculated water mains with degree of attack: 
 Good < 20 years, Normal 40 to 50 yrs   Slight.....   0.6       1.5     3.0 
                                        Moderate...   1.5       3.0     6.0 
                                        Appreciable   6.0      15.0    30.0 
                                        Severe.....  15.0      30.0    60.0 
 
 
 

CONDITION 
   PIPE MATERIAL                                     GOOD    NORMAL    POOR 
   (NEW & CLEAN UNLESS STATED)                        mm       mm       mm 
============================================================================ 
SMOOTH MATERIALS 
Aluminium, Brass, Copper, Glass, Perspex etc ......   ----      0.003   ---- 
 
ASBESTOS CEMENT ...................................   0.015     0.03    ---- 
 
CONCRETE 
Precast with “O” ring joints ......................   0.06      0.15    0.6 
 
PVC with solvent welded joints ....................   ----      0.03    ---- 
PVC with spigot and socket joints at 6 to 9 m .....   ----      0.06    ---- 
 
PITCH FIBRE .......................................   0.003     0.03    ---- 
 
GLASS FIBRE .......................................   ----      0.06    ---- 
 
 
 
 
 
CONDITION 
   PIPE MATERIAL                                     GOOD    NORMAL    POOR 

                                                      
# IDH_QROUGHNESS 
$ Absolute Roughness Tables for Pipes   
k Absolute Roughness Tables;f;FrictionFactor;Nikuradse; 



   (NEW & CLEAN UNLESS STATED)                        mm       mm       mm 
============================================================================ 
SLIMED SEWERS  Slimed to half depth & V = 0.75 m/s 
Concrete ..........................................   ----      6.0     ---- 
Asbestos Cement ...................................   ----      3.0     ---- 
Clayware ..........................................   ----      3.0     ---- 
u.P.V.C. ..........................................   ----      1.5     ---- 
 
SEWER RISING MAINS  All materials 
Normal operating velocity 1.1 m/s .................   ----      ----    3.0 
Normal operating velocity 1.3 m/s .................   ----      ----    1.5 
Normal operating velocity 1.5 m/s .................   ----      ----    0.6 
 
CONDITION 
   PIPE MATERIAL                                     GOOD    NORMAL    POOR 
   (NEW & CLEAN UNLESS STATED)                        mm       mm       mm 
============================================================================ 
CLAYWARE  Glazed or Unglazed 
With sleeve joints and “O” rings ..................   0.03      0.06    0.15 
With spigot and socket joints & “O” rings < 150 dia   ----      0.03    ---- 
With spigot and socket joints & “O” rings > 150 dia   ----      0.06    ---- 
 
UNLINED ROCK TUNNELS 
Granite and other homogeneous rocks ...............    60       150      300 
Diagonally bedded slates ..........................   ----      300      600 
 
EARTH CHANNELS 
Straight uniform artificial channels ..............    15        60      150 
Straight natural channels free from boulders, weeds   150       300      600 
 
 

IMPERIAL TABLES 
RECOMMENDED ROUGHNESS VALUES   Absolute roughness , k in inches 

( for use with Darcy - Weisbach formula ) 

CONDITION 
   PIPE MATERIAL                                     GOOD    NORMAL    POOR 
   (NEW & CLEAN UNLESS STATED)                       inches  inches   inches 
============================================================================ 
METAL 
Uncoated Steel ....................................   0.0006  0.0012  0.0024 

Coated Steel ......................................   0.0012  0.0024  0.006 
Galvanized Iron ...................................   0.0024  0.006   0.012 
Uncoated Cast Iron ................................   0.006   0.012   0.024 
Coated Cast Iron ..................................   0.0024  0.006   0.012 
 
Old tuberculated water mains with degree of attack: 
 Good < 20 years, Normal 40 to 50 yrs   Slight.....   0.024   0.06    0.12 
                                        Moderate...   0.06    0.12    0.24 
                                        Appreciable   0.24    0.6     1.2 
                                        Severe.....   0.6     1.2     2.4 
 
 
 
                                                           CONDITION 
   PIPE MATERIAL                                     GOOD    NORMAL    POOR 
   (NEW & CLEAN UNLESS STATED)                       inches  inches   inches 
============================================================================ 
SMOOTH MATERIALS 
Aluminium, Brass, Copper, Glass, Perspex etc ......   ----    0.00012  ---- 
 
ASBESTOS CEMENT ...................................   0.0006  0.0012   ---- 
 
CONCRETE 



Precast with “O” ring joints ......................   0.0024  0.006   0.024 
PVC with solvent welded joints ....................   ----    0.0012   ---- 
PVC with spigot and socket joints at 20 to 30 ft ..   ----    0.0024   ---- 
 
PITCH FIBRE .......................................   0.00012 0.0012   ---- 
 
GLASS FIBRE .......................................   ----    0.0024   ---- 
 
 
 
 
 
                                                           CONDITION 
   PIPE MATERIAL                                     GOOD    NORMAL    POOR 
   (NEW & CLEAN UNLESS STATED)                       inches  inches   inches 
============================================================================ 
SLIMED SEWERS  Slimed to half depth & V = 2.5 ft/s 
Concrete ..........................................   ----     0.24    ---- 
Asbestos Cement ...................................   ----     0.12    ---- 
Clayware ..........................................   ----     0.12    ---- 
u.P.V.C. ..........................................   ----     0.06    ---- 
 
SEWER RISING MAINS  All materials 
Normal operating velocity 3.6 ft/s ................   ----      ----   0.12 
Normal operating velocity 4.3 ft/s ................   ----      ----   0.06 
Normal operating velocity 5.0 ft/s ................   ----      ----   0.024 
 
CONDITION 
   PIPE MATERIAL                                     GOOD    NORMAL    POOR 
   (NEW & CLEAN UNLESS STATED)                       inches  inches   inches 
============================================================================ 
CLAYWARE  Glazed or Unglazed 
With sleeve joints and “O” rings ..................   0.0012  0.0024   0.006 
With spigot and socket joints & “O” rings < 6”  dia   ----    0.0012   ---- 
With spigot and socket joints & “O” rings > 6”  dia   ----    0.0024   ---- 
 
UNLINED ROCK TUNNELS 
Granite and other homogeneous rocks ...............    2.4     6.0     12.0 
Diagonally bedded slates ..........................   ----    12.0     24.0 
 
EARTH CHANNELS 
Straight uniform artificial channels ..............    0.6     2.4      6.0 
Straight natural channels free from boulders, weeds    6.0    12.0     24.0 
 



 



#$k  {bmc Pman.bmp}  Project Settings - overview 

Each time you use Helix delta-Q to analyse a pipe network, you need to open a new network 
file. In order to save time the program allows you to set up certain default values which are 
used when you add new items to the network. For example, you can set up a default liquid, 
slurry, gas and pipe. Each time you add a new node or pipe, the defaults settings and values 
are entered for you. You can then edit the items which differ from the default before solving 
the network. 

The default settings can be changed after you have created the network too, but as a first 
step in the network creation process, you need to set up these defaults. 

The Project Settings form also includes the Project Details, Designers Comments, Units of 
measure and it gives you an option of choosing the calculation method you want to use. 

{bmc hlpprj1.bmp} 

 

for more details select an option below : 

Project Details 

Set up your company name, client details, designers name, project details. 

Default Liquid 

Set up the default liquid. 

Default Slurry 

Set up the default slurry. 

Default Gas 

Set up the default gas. 

Default Pipe 

Set up the default pipe. 

Units of Measure 

Set up the project units. Units apply to all nodes and pipes in the network. 

Calculation Method 

Select the default calculation method to use and whether it is a liquid or gas network. This can 
be changed at any time. 

Designers Comments 

Enter designers comments about the network. 

Operating Costs 

Set up the project cost details for operating cost calculations. 

 

 
 

                                                      
#IDH_PROJSETTINGS 
$Project Details and Settings 
kProject Details;Units;Settings;Calculation Methods 



#$k  {bmc Pman.bmp}  Project Details 

Enter the project details in the text boxes provided. They are intended for record and checking 
purposes and appear on the printouts. 
 
The Altitude box is linked to the Atmospheric pressure available calculation. Enter the altitude 
of the project and site and press calculate to obtain an estimate of the Atmospheric pressure 
at site. 
 
{bmc hlpprj1.bmp} 

 

                                                      
#IDH_PROJDETAILS 
$Project Details 
kYour Company Name;Designers Name;Client Record;Project Details;Altitude;Atmospheric 
Pressure;Printouts;Header 



#$k  {bmc Pman.bmp}  Default Liquid 

Enter the default liquid details here. You can click on the Database button to open the Liquid 
Database. Then open the relevant data file, scroll down, click on the item required and Right 
Click with your mouse. Select the Copy to Network menu and the liquid details will be 
transferred to this form. 
 
The settings on this form will be added as the Liquid values for each node and pipe you add 
in the network diagram. You can then change individual values at different places in the 
network, if required, to cater for changing process conditions. 
 
If you have already drawn the network, you can change the Liquid values at all nodes and 
pipes in the network by Selecting the Apply Liquid To All Pipes button. This action will alter 
all existing nodes and pipes to reflect the default settings. Use this function with caution as 
there is no Undo facility! 
 
 
{bmc hlpprj2.bmp} 

 
 

                                                      
#IDH_PROJLIQ 
$Default Liquid Settings 
kLiquids;Changing Liquids in Network 



#$k  {bmc Pman.bmp}  Default Slurry 

Enter the default liquid details here. You can click on the Database button to open the Slurry 
Database. Then open the relevant data file, scroll down, click on the item required and Right 
Click with your mouse. Select the Copy to Network menu and the Slurry details will be 
transferred to this form. 
 
The settings on this form will be added as the Slurry values for each node and pipe you add in 
the network diagram. You can then change individual values at different places in the 
network, if required, to cater for changing process conditions. 
 
If you have already drawn the network, you can change the Slurry values at all nodes and 
pipes in the network by Selecting the Apply Slurry To All Pipes button. This action will alter 
all existing nodes and pipes to reflect the default settings. Use this function with caution as 
there is no Undo facility! 
 
 
{bmc hlpprj3.bmp} 

 
Definitions and Terminology 
For more details about the data required click on the links below: 
 
Description and Slurry number are for your record purposes only. 
Carrier Liquid Viscosity 
SG of Dry Solids 
Concentration by Mass (Weight) 
d50 and d80 Particle Size 
Closely Graded - enter a Y or a N 
Bingham Slurry - enter a Y or a N 
Yield Stress - applies to Bingham slurry only 
Co-efficient of Rigidity - applies to Bingham slurry only 
Pump Wear Factor - default value is 1 (0.9 would indicate a 10% deration of the the pump - 
this value is for future use) 
 
 
 

                                                      
#IDH_PROJSLURRY 
$Default Slurry Setting 
kSlurry Values;Setting up Slurry values;Changing Slurry Values in entire network 



#$k  {bmc Pman.bmp}  Default Gas 

Enter the default liquid details here. You can click on the Database button to open the Gas 
Database. Then open the relevant data file, scroll down, click on the item required and Right 
Click with your mouse. Select the Copy to Network menu and the Gas details will be 
transferred to this form. 
 
The settings on this form will be added as the Gas values for each node and pipe you add in 
the network diagram. You can then change individual values at different places in the 
network, if required, to cater for changing process conditions. 
 
If you have already drawn the network, you can change the Gas values at all nodes and 
pipes in the network by Selecting the Apply Gas To All Pipes button. This action will alter all 
existing nodes and pipes to reflect the default settings. Use this function with caution as there 
is no Undo facility! 
 
 
{bmc hlpprj4.bmp} 

 
Essential data required by this version of the program is: 
• Description 
• Molecular mass 
• Ratio of Specific Heat capacities  
• Gas Viscosity 
• Gas Temperature 
 
The Chemical Formula field is for information only and the Critical Temperature and Pressure 
are intended as calculation stop limits for future versions of the software. 
 
 
 

                                                      
#IDH_PROJGAS 
$Default Gas Setting 
kGas;Setting up the Network;Changing Gas values in a network 



#$k  {bmc Pman.bmp}  Default Pipe 

Enter the default liquid details here. You can click on the Database button to open the Pipe 
Database. Then open the relevant data file, scroll down, click on the item required and Right 
Click with your mouse. Select the Copy to Network menu and the Pipe details will be 
transferred to this form. 
 
The settings on this form will be added as the Pipe values for each node and pipe you add in 
the network diagram. You can then change individual values at different places in the 
network, if required, to cater for changing process conditions. 
 
If you have already drawn the network, you can change the Pipe values at all nodes and 
pipes in the network by Selecting the Apply Pipe To All Pipes button. This action will alter all 
existing nodes and pipes to reflect the default settings. Use this function with caution as there 
is no Undo facility! 
 
 
{bmc hlpprj5.bmp} 

 

                                                      
#IDH_PROJPIPE 
$Default Pipe Setting 
kSetting up Network Pipe Values;Changing Pipe Sizes 



#$k  {bmc Pman.bmp}  Units of Measure 

You can select the units of measure for data entry and reporting purposes. The program is 
supplied with a comprehensive set of  units to choose from. Click on the drop down arrow 
next to the current units and select the units you which to use. 
 
If you change the units, the changes will be reflected in all nodes and pipes in the network. if 
you have already entered data, changing the units does not convert the input data to the new 
values. The user must maintain the input values. For example, if you entered 12 bar as a 
node pressure then you change the units to kPa, the input value will remain as 12. 
 
{bmc hlpprj6.bmp} 
 
For Gas Networks you should work in absolute pressure units of measure when specifying 
node pressures. The Modified Darcy and Isothermal formulae require Absolute pressures. 
 
 
Adding Units of Measure not Listed 
You can add you own units of measure. The units are stored in text files in the program sub-
directory and can be edited using a text editor such as Notepad. Each unit has to entries in 
the file - the first is a description of the unit and the second is a conversion factor to the base 
units used by the program. These base units are the first item listed in the file and this first 
item should not be deleted or altered in any way. Example file VolFlowUnits.txt is listed below: 

 
l/s=1   <----------- the master value - do not alter 
l/min=0.0166666667 <----------- your values - enter as many as you like 
l/hr=0.0002777778 <----------- your values - units followed by conversion to master units 
m3/hr=0.27777778 <----------- your values 
m3/s=1000 
m3/min=16.666667 
m3/day=0.011574074 
 

                                                      
#IDH_PROJUNITS 
$Units of Measure 
kUnits;English Units;SI Units;Metric;Adding your own units;Changing Network Units;Absolute 
pressures;Gas Pressures 



#$k  {bmc Pman.bmp}  Calculation Method 

The program allows the user to choose from a number of methods for solving the network. 
 
The first choice which must be made is whether it is a Liquid (incompressible fluid) or a Gas 
(compressible fluid) network. You cannot analyse a network containing both gasses and 
liquids in the same file. Separate the network into a Gas network and a separate Liquid 
network. 
 
{bmc hlpprj7.bmp} 

 
If you select Liquid you can then choose to use the Darcy-Weisbach method or the Hazen-
Williams method. 
 
If you select Gas you can choose to use the Isothermal or the Modified Darcy methods. 
 
For Slurry networks choose Liquid and use the Darcy - Weisbach method. 

 
 

                                                      
#IDH_PROJCALC 
$Calculation Method 
kCalculation Method;Formulae;Darcy;Hazen-Williams;Isothermal;Modified Darcy;Slurry 
Calculations 



#$k  {bmc Pman.bmp}  Designers Comments 

This form allows the designer to record comments about the design. These comments may 
be used to explain why certain options were used in the network or any other comments, 
record or description the user would like to record. They can also be used to describe the 
network in words. 
 
You are allowed to enter up to fifteen lines of comments, each containing up to 80 characters 
per line. 
 
{bmc hlpprj8.bmp} 

 
 

                                                      
#IDH_PROJCOMMENTS 
$Designers Comments 
kDesigners Comments;Keeping Records;Network Description 



#$k  {bmc Pman.bmp}  Project Operating Costs 

The program uses the Operating Cost parameters to compare individual pipe capital costs 
versus the energy cost of operating the pipe. i.e. the cost of the head losses in the pipe. The 
designer can then decide whether a larger pipe diameter with higher capital cost but a lower 
head loss, and therefor a lower operating cost, will be more economical than a smaller pipe 
diameter with a higher head loss. 
 
{bmc hlpprj9.bmp} 

 
The total energy cost is calculated is follows: 
 

absorbed power kW QHg
=

100
 

 
Efficiency is taken as unity as the calculation is intended for comparison purposes. 
 
Operating cost C EnergyCostPerUnit AbsorbedPower OperatingHours= * *  
 
 
 
 

                                                      
#IDH_PROJCOSTS 
$Project Operating Costs 
kEnergy Cost;Economical Pipe Diameter;Cost of Head Losses 



 



#$k  {bmc Pman.bmp}  Getting Started - Creating and Solving a Pipe 
Network 

Using delta-Q is easy - follow these steps to create and solve your first network. You can get 
context sensitive help by pressing F1 at any time. You can also Print this topic by pressing the 
Print Button. 
 
1. Install the program. 

2. Run delta-Q and Select the Pipe Networks option on the main form. 

3. The Network Analysis form will be displayed. Select File, New and type in a file name for 
your network. Press OK. 

4. The Project Details form will be displayed. Enter the project details and set up the Default 
Liquid, Slurry, Gas and Pipe by entering data in the relevant tabbed pages. 

5. Click on the Units of Measure tab and select the units you want to use. The important ones 
are Flow, Head, Pressure, Length and Diameter units. 

6. Click on the Calculation Method tab and Select Liquid and Darcy-Weisbach. The first 
network will be a simple liquid network. 

7. Close the Project Settings form by clicking the OK button at the bottom of the form. You will 
be returned to the Network Diagram form, and it will now be open for editing, although still 
blank. 

8. Click on the  Fixed Head Node (Tank) Toolbutton on the left of the screen. Drop a 
fixed or known head node in the network by clicking in drawing area as shown below: 

9.  
                                                      

#IDH_KSQSG 
$Quick Start Guide 
kGetting Started;Creating Networks 



10. Add another tank by clicking in another square to the right and below the first tank. 

11. Click on the  Pipe Toolbutton and then click with the mouse on the first Tank, hold the 
left mouse button down and move the mouse to the second tank. Release the left mouse 
button whilst it is over the second tank. A line will be drawn joining the two tanks. Press the 
Redraw button above the drawing area and the pipe will be redrawn with a direction arrow. 
You have now drawn two tanks connected by a pipe and to complete the network we need to 
set the tank levels and the pipe details. Your sketch should look like this: 

12.  

13. Every network should have known head or pressure nodes at the terminal points of the 
network. The known head nodes may be tanks or pumps (or pressure vessels and 
compressors for gas networks). Junction, sprinkler and vessel nodes are generally un-known 
head nodes and the heads will be calculated by the program. 

14. Click on the  Pointer Toolbutton. This is the network selection tool. Click on the 
Details tab to right of the drawing area.  

15.  

16. Click on the first tank in the diagram. The tank details will appear in the Details data grid on 
the right hand side of the diagram. The pale yellow area of the grid is where you can enter 
data such as the description of the tank, Equipment number and other node data. The default 
Liquid details you setup in the Project settings form will be displayed. The value entered in 
the altitude box in the Project Details form will be displayed in the Datum Level cell, in this 
case 50m. Click in this cell (Datumn Level) and change the value to 70m. We will leave the 
second tank’s level at 50m so that there is a differential of 20m. 

17. Move the mouse over the pipe in the diagram. The cursor will change to display a Hand when 
it is over the pipe. Left Click and the Pipe Details will be displayed in the Data grid. The 
Default liquid details will be displayed followed by pipe and fitting details. The pipe details will 
be the default values set up under Project Settings. Click in the Pipe Length Cell and enter a 
value of 50m. The network is now complete and we can solve for the flow rate by pressing 



the Solve Network button. The Flow rate and the node heads will be shown in the diagram 
as below: 

18.  

19. You can add fittings to the pipe by entering a fitting K value in the K value cell or you can go 
to a list of fittings. Click on the pipe to give it the focus. Now move the mouse over the Fitting 
K value cell. The cursor will change to a Hand, indicating that that cell has a drill down 
function. Double click the left mouse button in the Fitting K value cell. A new form with two 
lists will be displayed. The top list shows a list of fittings in the Fittings database file. Scroll 
down this list and select the fittings you require by double clicking on it. It will be transferred 
to the bottom list - a list of fittings in the current pipe. See the Pipe Fittings help topic for more 
details. You can build up a list of fittings for the pipe using this method. Click the OK button to 
close the Pipe Fittings form. The Total K and Kf values will be transferred to the Pipe data 
grid. If you press the Solve Button the new flow rate, which takes into account the fitting 
losses, will be displayed. 

20. Now let us add an unknown head junction and a pump to the network. Click on the Junction 

Toolbutton  and drop a Junction in the diagram somewhere below the first tank. Click 

on the Pump Toolbutton  and add a Pump Node below the Junction node. Click on the 
Pipe Toolbutton and then click on the Pump Node in the diagram. and holding the left mouse 
button down, drag the mouse until it is over the Junction node. Release the mouse button 
and the pipe will be drawn. Now connect the first Tank to the junction and then the junction to 
the second tank. Your network should look like the diagram below. Click on the Pump Node. 
In the Details data grid enter a value of 25 m (say) in the Pump Head cell. Now click on each 
of the three pipes you have just added and enter a pipe length for each (say 23, 48 and 72.5 
m). Now press the Solve Network button. The result will look something like this 



21.  

22. You can continue to add nodes and pipes in this way.  

23. You can view a System  curve of any of the pipes. Click on the Graphs tab. Select the 
Selection (Pointer) Toolbutton and click on any pipe in the network. The System graph will 
drawn.  

24.  

25. If you make changes to the network whilst the system graph is visible, you can refresh the 
graph by pressing the Draw button. You can print this graph by pressing the Print button. 
The Flow and Head scales can be changed by changing the Flow scale and the Plot 
Increment value changes the number of points calculated and drawn on the graph ( A high 
value plots more points). 



26. We can also add a sprinkler nozzle to this network. select the Nozzle Toolbutton   and 
drop a nozzle to right of the first tank. Now draw a pipe from the first tank to the nozzle and 
another pipe from the nozzle to the second tank. Now click on the Selection Toolbutton and 
click on the new pipe to give it the focus and enter a relevant length (say 6 m and 15 m for 
the other pipe). Click on the Nozzle and enter a value of -10 in the Flow  In (+) / Out (-) cell. 
This cell is where you enter sources or supply flows into and sinks or demand flows out of the 
network. A minus indicates flow out of the network at that point. You can also specify external 
flows at Junction nodes. Click on the Solve Network button. You will see that the flow out 
from the nozzle junction will be equal to the flow into the nozzle minus the external flow value 
you entered, as shown below. Now click on the Reports tab and click on Display External 
Flow Rates check box. The external flow rates will be drawn on the network. 

27.  

28. Experiment with the other Display ...  checkboxes. You will usually find that you can display 
two or three values comfortably at a time on a network. We suggest that you can display a 
few, print the network, change the display and then print it again. This prevents the diagram 
from becoming too crowded. 

29. You can copy data from the Pipe, Liquid and Slurry Databases to the current node or pipe. 
Simply select the item in the diagram, then Right click in the Data Grid. A pop-up menu 
allows you to retrieve data from the databases or to print the Pipe or Node Data currently 
shown in the Data Grid. 

30. You have now completed a network design. You can print the Network Diagram by pressing 
the Print Network Diagram button on the Reports tab. You can view the Data Reports by 
clicking on the button on the same tab. 

31. The Data Reports form allows you to view and print the network data. Click on each tab sheet 
to view the different reports, print some of them if you wish. You can also view the network 
solution in Graph form. This is a useful tool for you to check for minimum or maximum values 
at a glance. For example, you can check the Node pressures or the velocities and view the 
results in a graph. 

32. You can Export Data from the Data Reports. For example, click on the Pipe Data tab and 
click anywhere in the data grid to give it the focus. Now select the Edit, Copy menu. The 
data grid has been copied to the Windows clipboard and you can paste it into another 
application such as a spreadsheet program. For example, if you have MS Excel installed, 
start it up and when it is open at a blank spreadsheet, click in the top left cell, press the Edit, 



Paste menu option, and the data will be pasted in that column. Now, to spread the data into 
multiple columns, select the column where the data was pasted, select the Data, Text To 
Columns...menu option, select the Delimited Option  in the wizard, Press the Next button, 
set the Comma Delimiter option to on (because it is a comma separated value file which is 
pasted from Helix delta-Q) and press the Finish button. The Pipe data should now be in 
separate columns in the spread sheet and you can add, modify, customize and print the data. 
Refer to your spreadsheet application help file for details on how to parse comma separated 
values if you have any difficulty. 

33. You have now created a simple network, solved it and viewed and printed the data. 

34. You can delete nodes by using the Delete Toolbutton  . Click on the Toolbutton then 
click on the node you want to delete. Confirm your deletion and the program will remove the 
node and all pipes connected to that node. 

35. You can change the size of the diagram by selecting a Zoom percentage and you can alter 
the number of Decimals displayed on the diagram and in the Data Grid and the Data Reports 
form by selecting values from the Decimals drop down box above the diagram. 

36. You can move nodes. Click the Selection Toolbutton, click on a node and hold the left mouse 
button down whilst you drag the node to a new un-occupied cell. When you release the 
mouse button the node and pipes will be re-drawn in the new position.  

37.  

38. You can move more than one node at a time. Click in an empty cell and hold the mouse 
down to drag a rectangular window around the cells you want to move. When you release the 
mouse, move it to inside the rectangular window and a cross with four pointers will appear. 
Left click and hold down to drag the window a few cells and then release the mouse. The 
cells will be re-drawn in the new position. 

39. You can change the liquid details in any pipe by selecting the pipe and altering the values in 
the Data Grid. in addition to manually changing the values you can select a liquid from the 
database. If you move the mouse over the Liquid Description cell, a Hand cursor will be 
displayed. Double click and the Liquid Database will be displayed. Click on the liquid you 
want to use, Right click with the mouse and select the Copy Record to Network option. The 
liquid details will be copied to the network data grid. 

40. Orifice Plates. You can an add an orifice plate to any pipe in the network. Select the pipe and 
in the Data Grid, enter an Orifice Plate Diameter. This diameter should be less than the pipe 
Inside Diameter (preferably less than 70% of the pipe ID for good accuracy). Press the Solve 



Button and the program will calculate the new flow rate in the system. The Orifice Head 
losses are shown separately in the data grid. To remove the orifice enter a zero for the 
Orifice Plate Diameter. A pipe with an orifice plate present is drawn with a small 
perpendicular line crossing it just upstream of the direction arrow head, as shown below: 

41.  

42. For Slurry Networks,  click on a pipe and in the Details tab, click the Slurry check box to 
on. The Liquid label will change to Slurry. Double click in the cell next to Slurry and the Slurry 
input form will be displayed. Enter the Slurry details and press OK to return. The network will 
now be analysed with slurry flowing in the pipe selected when you press Solve. You should 
check the settling velocity of the slurry against the actual velocity. It is also useful to use the 
System graph to view where your duty point falls if you have a slurry in the network. For 
Settling slurries, you should select a pipe size which will give you a velocity close to or above 
the settling velocity. For example, the following flow rate is too low (or pipe size too large, or 
pipe too long) as the duty point falls well below the slurry settling velocity. 

43.  

44. You should increase the velocity in the pipe by increasing the available head or reducing the 
pipe diameter so that the duty point falls closer to the point of intersection between the 
settlement curve and the main curve. Refer to Slurry Settling Calculations. 

45. For Bingham slurries, it is possible that the head available across a pipe is insufficient to 
overcome the initial yield stress. In this case, the flow would be zero, as there is insufficient 
head to overcome the initial resistance to flow. The flow in the pipe will be set to zero when 



the network is analysed. You should increase the available head to avoid this situation. If the 
flow becomes turbulent, the slurry behaves like a normal Newtonian fluid and the system 
curve shows a pronounced increase in slope beyond this point. Operating too far into the 
turbulent region wastes energy in the form of high friction losses for a small increase in flow 
rate. Operating in the laminar zone, you can get a large increase in flow rate with a small 
increase in head, so the best operating point is close to the ‘knee’ of the curve. 

46.  

47. Note: Irregularities near the ‘knee’ of the curve are due to the flow being in the Transition 
zone between laminar and turbulent flow. These irregularities may not always appear, and 
they depend on the plot increments used. 

48. The Vessel  Toolbutton is treated in the same way as an unknown pressure Junction 
node - it is intended only for visual differentiation from other nodes.  

49. Gas Networks. For gas networks, the method of operation is basically the same as 
described above except for the following: 

• When you set-up the Project Details in step number 4 above, you must select the Gas 
option on the Calculation Method tab. The default gas details must also be added. 

• After you have you have opened a new file (step 7) , click on the Options tab and select 
the Use Gas Picture Icons button. This will replace the Tank button with a Gas Cylinder 

 icon in the network diagram. (This is optional - you can analyse the network 
using any of the picture options). 

• Instead of entering liquid details you must enter gas details. You can double click in the 
Gas Description value cell to open the Gas Database file. 

• You should work in Absolute pressure units for all known pressure nodes such as 
vessels and pumps / compressors. 

• Refer to Choked Flow conditions for details on sonic flow conditions. 

• You can calculate any type of gas flow system such as long gas pipe lines, steam lines, 
compressed air lines, air conditioning and ventilation ducts, dust exctraction systems - 



basically any compressible fluid. You must have at least the following data about the 
gas: 

• The molecular weight of the gas 

• The ratio of the specific heat capacities Cp/Cv 

• The viscosity of the gas 

• the inlet temperature of the gas. 

• Refer to the Gas database for typical values for Air and some common gasses. 

50. Finally, you should Save your network design file regularly. Each Network design is stored in 
two files in the Data\Projects sub-directory. The first file has an extension of .NWK which 
contains the node and pipe data and the second an extension of NWK which contains the 
Project Setup data. You should always back-up and keep these files together, as both are 
required to open a network. 

 



#$k  {bmc Pman.bmp}  Pipe Fittings 

Pipe Fittings can be added as individual items to any pipe or they can be represented by a 
global K value without having to enter each fitting. 
 
To enter a global value, simply select the pipe in the network diagram, then enter the K value 
and / or the Kf value in the Data Grid. 

 
 
To enter individual fittings, select the pipe in the diagram, move the mouse over the K Value cell. 
The cursor will change to a Hand. Double click with the left mouse button and the Pipe Fittings 
form will be displayed. 
 

                                                      
#IDH_KSFITTINGS 
$Pipe Fittings 
kPipe Fittings;Fitting Losses;K value;Kf value;Shock losses;Equivalent Length 



 
 
The top grid is a list of fittings from the file called KFittings.dat. You can open and edit this file 
using a text editor. The bottom grid is a list of fittings present in the pipe.  
 
Scroll down the top grid and Double click on an item in the list. It will be added to the list below, 
and the total K values re-calculated. 
 
You can delete an item from the pipe list by double clicking on it. You can also delete all the 
items by pressing the Clear List button. 
 
There are two methods used for calculating fitting losses in this program. The first is the 
standard shock loss or velocity head method in which a K factor, which depends on the fitting, is 

multiplied by the velocity head i.e. Hf K V
g

=
2

2
. This method is the one which should be used 

for all fittings if the Hazen-Williams method is used. It does not allow for changes in the fluid 
viscosity. 
 
 
The other fitting loss calculation method uses a Kf factor and the velocity head. The Kf factor is 
multiplied by the Darcy friction factor to arrive at the K value, making the fitting loss vary as the 

friction factor changes (due to changes in fluid viscosity or turbulence). i.e. Hf f Kf V
g

= •
2

2
 

This method is not suitable for use when the Hazen-Williams calculation method is used. 
 
NOTE: In some cases, the K value data file contains values for both the K Value and the Kf 
value. YOU SHOULD USE ONE OR THE OTHER, NOT BOTH. After you have copied the fitting 
from the top grid into the bottom grid, you should enter the number of fittings of that type and 
also delete the K value you do not want to use, leaving the value do want to use. You can mix 
and match K values and Kf values in the same pipe in combination you wish. In fact, some fitting 
losses, such entry and exit losses,  are pure shock losses and should be specified as K values.  
 
You can add your own descriptions and K and Kf values - you don’t have to select them from the 
database. 
 
If you would rather use the L/d equivalent length method to allow for fittings, you can do so by 
doing a manual calculation of the total equivalent pipe length for the fittings and then adding this 
length to the actual pipe length. In this case you can leave the K values as zero. 
 



When you have entered the Fittings, press the OK button and the total K value and Kf values will 
be transferred to the Network Pipe Data grid. Press the Solve Button to see the new flow and 
head losses. 
 
You can print a list of fittings in each pipe in the Data Reports form. 
 



#$k  {bmc Pman.bmp}  Entering Slurry Data 

The Slurry data entry form is shown below.  
 

 
 
You should enter data for all item in the left hand column. If it is a settling slurry, you do not need 
to enter the Yield Shear Stress or the Co-efficient of Rigidity, as these apply to Bingham type 
slurries only. 
 
Once you have entered the data, press the Calc Slurry Values button and the values marked in 
blue will be calculated for you. You can also obtain an explanation of the parameters required by 
clicking on the item and pressing F1 for context sensitive help. 
 
You can retrieve data from the Slurry Database by clicking the Slurry Database button and 
selecting a slurry from the data list then Right clicking and pressing the Copy Data menu option. 
The selected slurry will be transferred to the current pipe in the network. Press the Calc Slurry 
Values button to ensure that the current values are transferred to the pipe for calculation 
purposes. 
 
Press OK to return to the Network Diagram. 
 

                                                      
#IDH_KSSLURRY 
$Entering Slurry Data 
kSlurry Data;SG;Slurry;Rheology 



#$k  {bmc Pman.bmp}  Data Reports 

The Data Reports form allows you to view and print the network data. Click on each tab sheet to 
view the different reports, print some of them if you wish. The Pipe Data tab sheet shows the 
network pipe details in tabular form. The Node Data tab shows details about each network 
node. The Pipe Fittings tab shows the pipe fittings in each pipe in the network. If you did not 
enter individual pipe details, and you only used the total K or Kf value for fitting losses, the 
Fittings data sheet will be blank.  
 

 
 
Right click on any of the tables - a pop-up menu will allow you to print any of the tables. 
 
You can alter the number of Decimals displayed in the Data Reports form by selecting values 
from the Decimals drop down box above the Network diagram. 
 
You can also view the network solution in Graph form. This is a useful tool for you to check for 
minimum or maximum values at a glance. For example, you can check the Node pressures or 
the velocities and view the results in a graph. To use this facility, Click on the Graph tab sheet. A 
Graph of the Flow Rates in each pipe in the network will be shown. Right Click on the graph 
and click on a menu option. A graph showing that particular variable will be drawn. Some of the 
graphs apply to the pipes in a network and some graphs apply to the Nodes in a network. A 
commonly used graph is one showing the velocities in each pipe, such as the one below. 

                                                      
#IDH_KSREPORTS 
$Network Data Reports 
kReports;Printing Data;Pipe Data;Node Data;System Graphs 



 
 
You can print this graph. Right click on the graph and select the Print Graph menu option. The 
graph will be printed at the same size as shown on the Image Size scroll bar on the Reports tab 
on the Network form. (The default size is 50% of the printer paper size) 
 
The Data Reports form also has a System Graph  tab sheet where for Liquid Networks a 
system graph for each pipe in the network can be displayed. Click on the System Curves tab 
and then click on the Draw System button. The program will loop through each pipe in the 
network and construct a system graph by performing 20 friction loss calculations at different flow 
rates for each pipe. This procedure may take some time on large networks - it also depends on 
your PC hardware speed. On some systems it may be necessary to press the System Curves 
button twice to get all the curves to display simultaneously. You can adjust width (aspect ratio) 
that the curves are drawn at by moving the column dividing line between curves with your 
mouse. 
 
The Designers comments tab sheet allows you enter any comments or notes about the Design 
for record or information purposes. These comments are the same comments as those 
displayed on the Project Settings form which is accessed from the Units button in the Network 
Design form. 
 
The Print tab allows you to print various tables and network data. 
 
You can also Export Data to other applications such as spreadsheet programs, where you can 
customise the layout and add your own data before printing. 
 



#$k  {bmc Pman.bmp}  Exporting Data 

You can Export Data from the Data Reports. For example, click on the Pipe Data tab and click 
anywhere in the data grid to give it the focus. Now select the Edit, Copy menu. The data grid 
has been copied to the Windows clipboard and you can paste it into another application such as 
a spreadsheet program.  
 
For example, if you have Microsoft Excel installed, start it up and when it is open at a blank 
spreadsheet, click in the top left cell, press the Edit, Paste menu option, and the data will be 
pasted in that column. Now, to spread the data into multiple columns, select the column where 
the data was pasted, select the Data, Text To Columns...menu option, select the Delimited 
Option  in the wizard, Press the Next button, set the Comma Delimiter option to on (because it 
is a comma separated value file which is pasted from Helix delta-Q) and press the Finish 
button. The Pipe data should now be in separate columns in the spread sheet and you can add, 
modify, customize and print the data. Refer to your spreadsheet application help file for details 
on how to parse comma separated values if you have any difficulty. 
 
 
 

                                                      
#IDH_KSEXPORT 
$Exporting Data 
kExporting data;Excel;Spreadsheets;Other Applications;Copying Data to Other Applications 



#$k  {bmc Pman.bmp}  Orifice Diameter 

The Orifice Calculations are based on differential pressure calculations. 
 
Typical Orifice Plate Arrangements  

  
  

The orifice plate flow measurement principle is commonly known as the ∆P  
principle. This program uses the following formula to calculate the three options offered. 
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where 10000 < R < 200000 
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 where R > 200000 

 
where : 
 
Sm is the sizing factor 
Q is the flow rate in US gal/min 
B is the Beta ratio d/D 
d is the orifice diameter in inches 
D is the pipe diameter in inches 
Nvg is a unit correction factor = 5.666 
R is Reynolds number 
h is the differential pressure in inches H2O 
Fa thermal expansion factor - varies with temperature 

                                                      
#IDH_KSORIFICE 
$Orifice Plate Calculations 
kOrifice;Orifice Plate Calculation;dP Calc;Tappings;Vena Contracta 



 
Note : For Reynolds numbers of less than 10000 the accuracy of the calculation diminishes as 
the flow becomes less turbulent. 
 



#$k  {bmc Pman.bmp}  Network Calculation Method and Accuracy 

Helix delta-Q uses a combination of the Linear Theory and Newton-Raphson methods coupled 
to a matrix algebra calculator to solve for pipe network flow rates and pressure drops. The 
program algorithm has been built from the ground up by Helix Technologies and it utilises the 32 
bit power of modern computers to arrive at a solution without the user having to enter flow or 
head loss estimates.  
 
The program sets up random pressure values for the unknown pressure nodes, calculates the 
flow rates and pressure drops in each pipe in the network, using the user selected method of 
calculation, and then adjusts the node pressures and repeats the process until the sum of the 
square roots of the change in node pressures of all nodes is less than the network error factor 
value specified. The number of iterations used to arrive at the solution is shown on the status 
bar at the bottom of the network diagram. You can alter the accuracy by selecting the Options 
tab and selecting values from the drop-down boxes provided. The smaller the error factor, the 
more accurate the solution. The Maximum number of iterations allowed prevents the program 
from running on indefinitely with the results oscillating or ‘hunting’ about the solution i.e. the 
process stops when the maximum number of iterations has been reached, even if the network 
has not fully converged. You can increase the accuracy of a calculation by selecting a smaller 
error factor and by increasing the maximum number of iterations allowed. 
 
You can terminate a calculation run at any time by pressing the ESC key or by pressing the 
Cancel Calculation Run button. 
 
For some networks, especially gas networks where you have choked flow conditions present, 
you may find that you need to decrease the network accuracy to some value below the default 
setting (which is set very accurate), in order to obtain a solution. This usually occurs where there 
is insufficient pipe length to give a solid basis for friction loss changes due to flow rate changes. 
When the program has correctly arrived at a solution of the network, it will display a message 
Network Solved in the status bar below the network diagram. You should not use the results of 
any network calculation which has not converged to a solution. 
 
If you have a network which will not converge, try changing the pipe length or diameter to 
increase the friction loss, or alter a known pressure node head or pressure. 
 
In some very rare cases, the algorithm my result in an ill-conditioned or a singular matrix. A 
message to this effect will be displayed. Do not use the network results if this happens. 
 
 

                                                      
#IDH_KSACCURACY 
$Calculation Method and Accuracy 
kCalculation Accuracy;Convergence;Solution of Network;Iterations 



 



#$k  {bmc Pman.bmp}  Liquids Database 

Helix delta-Q is provided with a number of data files for you to use to store reference data.  
 
Liquid data may be stored in the Liquid Database files. These files are located in the Data\Liquids 
sub-directory and have a .DAT file extension. 
 

 
 
To open an existing Liquid data file, select the Database, Liquid Database menu option. The 
current file will be opened. When you are in the Database file you can select the File menu and 
open existing files or add new files. 
 
You can add new records to the data file by clicking in the empty row at the bottom of the 
datagrid. Fill in the required parameters and press File, Save. You can use the Edit menu 
options and hot keys to copy records for quick data capture routines. 
 
You can Sort data in the grid by double clicking on the column heading or clicking in the column 
you want to sort by and pressing the Sort menu. 
 
If you right click on an item in the data grid, you can select that item for transfer to the Pipe 
Network Diagram. For this option to function, the Data file should be called from the Pipe Network 
diagram form. 
 
Importing Data 
You can import data from other sources. The data should be in a Comma Separated Value (CSV) 
text file format, with the values in the same order as the columns in the datafile. To import data, 
open the file you want to add to, and add a new record by clicking in the last row in the 
description column. Now select the Data Transfer, Import CSV Text File menu option and open 
the CSV file. The program will attempt to copy the data into the file, starting at the cursor position. 
A CSV file is an ordinary text where the individual values in one row of data are separated by 
commas. for example ‘Water,1.31,10,1000,0.8’ would be a record for water at viscosity = 1.31, 
temperature at 10 deg, density at 1000 kg/m3 and Vapour pressure at 0.8. Each record should be 
on a new line in the CSV file. 
 
Don’t forget to save your data after importing it. The program will automatically enter a value of 1 
if you leave a numeric value blank. 
 

                                                      
#IDH_DBLIQ 
$Liquids Database 
kData;Liquids;Files;Importing Liquid Data 



You can print the data file by selecting the File, Print menu option. 



#$k  {bmc Pman.bmp}  Gas Database 

Helix delta-Q is provided with a number of data files for you to use to store reference data.  
 
Gas data may be stored in the Gas Database files. These files are located in the Data\Gasses 
sub-directory and have a .DAT file extension. 
 

 
 
To open an existing Gas data file, select the Database, Gas Database menu option. The current 
file will be opened. When you are in the Database file you can select the File menu and open 
existing files or add new files. 
 
Essential data required by this version of the program is: 
• Description 
• Molecular mass 
• Ratio of Specific Heat capacities  
• Gas Viscosity 
• Gas Temperature 
 
The Chemical Formula field is for information only and the Critical Temperature and Pressure are 
intended as calculation stop limits for future versions of the software. 
 
You can add new records to the data file by clicking in the empty row at the bottom of the 
datagrid. Fill in the required parameters and press File, Save. You can use the Edit menu 
options and hot keys to copy records for quick data capture routines. 
 
You can Sort data in the grid by double clicking on the column heading or clicking in the column 
you want to sort by and pressing the Sort menu. 
 
If you right click on an item in the data grid, you can select that item for transfer to the Pipe 
Network Diagram. For this option to function, the Data file should be called from the Pipe Network 
diagram form. 
 
Importing Data 
You can import data from other sources. The data should be in a Comma Separated Value (CSV) 
text file format, with the values in the same order as the columns in the datafile. To import data, 
open the file you want to add to, and add a new record by clicking in the last row in the 

                                                      
#IDH_DBGAS 
$Gas Database 
kData;Gasses;Files;Importing Gas Data 



description column. Now select the Data Transfer, Import CSV Text File menu option and open 
the CSV file. The program will attempt to copy the data into the file, starting at the cursor position. 
A CSV file is an ordinary text where the individual values in one row of data are separated by 
commas. for example ‘Water,1.31,10,1000,0.8’ would be a record for water at viscosity = 1.31, 
temperature at 10 deg, density at 1000 kg/m3 and Vapour pressure at 0.8. Each record should be 
on a new line in the CSV file. 
 
Don’t forget to save your data after importing it. The program will automatically enter a value of 1 
if you leave a required numeric value blank. 
 
You can print the data file by selecting the File, Print menu option. 
 
 



#$k  {bmc Pman.bmp}  Slurry Database 

Helix delta-Q is provided with a number of data files for you to use to store reference data.  
 
Slurry data may be stored in the Slurry Database files. These files are located in the Data\Slurries 
sub-directory and have a .DAT file extension. 
 

 
 
To open an existing Slurry data file, select the Database, Slurry Database menu option. The 
current file will be opened. When you are in the Database file you can select the File menu and 
open existing files or add new files. 
 
You can add new records to the data file by clicking in the empty row at the bottom of the 
datagrid. Fill in the required parameters and press File, Save. You can use the Edit menu 
options and hot keys to copy records for quick data capture routines. 
 
Definitions and Terminology 
For more details about the data required click on the links below: 
 
Description and Slurry number are for your record purposes only. 
Carrier Liquid Viscosity 
SG of Dry Solids 
Concentration by Mass (Weight) 
d50 and d80 Particle Size 
Closely Graded - enter a Y or a N 
Bingham Slurry - enter a Y or a N 
Yield Stress - applies to Bingham slurry only 
Co-efficient of Rigidity - applies to Bingham slurry only 
Pump Wear Factor - default value is 1 (0.9 would indicate a 10% deration of the the pump - this 
value is for future use) 
 
 
You can Sort data in the grid by double clicking on the column heading or clicking in the column 
you want to sort by and pressing the Sort menu. 
 
If you right click on an item in the data grid, you can select that item for transfer to the Pipe 
Network Diagram. For this option to function, the Data file should be called from the Pipe Network 
diagram form. 
 
Importing Data 

                                                      
#IDH_DBSLURRY 
$Slurry Database 
kData;Slurry;Files;Importing Slurry Data 



You can import data from other sources. The data should be in a Comma Separated Value (CSV) 
text file format, with the values in the same order as the columns in the datafile. To import data, 
open the file you want to add to, and add a new record by clicking in the last row in the 
description column. Now select the Data Transfer, Import CSV Text File menu option and open 
the CSV file. The program will attempt to copy the data into the file, starting at the cursor position. 
A CSV file is an ordinary text where the individual values in one row of data are separated by 
commas. for example ‘Water,1.31,10,1000,0.8’ would be a record for water at viscosity = 1.31, 
temperature at 10 deg, density at 1000 kg/m3 and Vapour pressure at 0.8. Each record should be 
on a new line in the CSV file. 
 
Don’t forget to save your data after importing it. The program will automatically enter a value of 1 
if you leave a numeric value blank. 
 
You can print the data file by selecting the File, Print menu option. 
 
 



#$k  {bmc Pman.bmp}  Pipe Database 

Helix delta-Q is provided with a number of data files for you to use to store reference data.  
 
Pipe data may be stored in the Pipe Database files. These files are located in the Data\Pipes sub-
directory and have a .DAT file extension. 
 

 
 
To open an existing Pipe data file, select the Database, Pipe Database menu option. The current 
file will be opened. When you are in the Database file you can select the File menu and open 
existing files or add new files. There are many different pipe data files supplied with delta-Q. 
Browse through the names and view any which may be of interest to you. Most of this data has 
also been combined into a single data file called All Pipes Combined.dat. You can also create a 
new file and add your own data. 
 
You can add new records to the data file by clicking in the empty row at the bottom of the 
datagrid. Fill in the required parameters and press File, Save. You can use the Edit menu 
options and hot keys to copy records for quick data capture routines. 
 
You can Sort data in the grid by double clicking on the column heading or clicking in the column 
you want to sort by and pressing the Sort menu. 
 
If you right click on an item in the data grid, you can select that item for transfer to the Pipe 
Network Diagram. For this option to function, the Data file should be called from the Pipe Network 
diagram form. 
 
Importing Data 
You can import data from other sources. The data should be in a Comma Separated Value (CSV) 
text file format, with the values in the same order as the columns in the datafile. To import data, 
open the file you want to add to, and add a new record by clicking in the last row in the 
description column. Now select the Data Transfer, Import CSV Text File menu option and open 
the CSV file. The program will attempt to copy the data into the file, starting at the cursor position. 
A CSV file is an ordinary text where the individual values in one row of data are separated by 
commas. for example ‘Poly,Class 16,110,99,110,65,1600,0.003, 15.65’ would be a record for a 
Poly pipe, Class 16, NB 110, ID 99, OD 110 Temperature 65, roughness 0.003 mm and pipe cost 
$15.65. Each record should be on a new line in the CSV file. 
 
Don’t forget to save your data after importing it. The program will automatically enter a value of 1 
if you leave a numeric value blank. 
 

                                                      
#IDH_DBPIPE 
$Pipe Database 
kData;Pipes;Files;Importing Pipe Data 



You can print the data file by selecting the File, Print menu option. 
 



#$k  {bmc Pman.bmp}  Pump Database 

Helix delta-Q is provided with a number of data files for you to use to store reference data.  
 
Pump data may be stored in the Pump Database files. These files are located in the Data\Pumps 
sub-directory and have a .DAT file extension. 
 

 
 
To open an existing Pump data file, select the Database, Pump Database menu option. The 
current file will be opened. When you are in the Database file you can select the File menu and 
open existing files or add new files. 
 
You can add new records to the data file by clicking in the empty row at the bottom of the 
datagrid. Fill in the required parameters and press File, Save. You can use the Edit menu 
options and hot keys to copy records for quick data capture routines. 
 
The linking of Pumps into the delta-Q version 2 program is still under development. Use the delta-
Q version 1 for performing pump selections, pumps in series, system curves etc. 
 
Importing Data 
Not implemented yet. 
Don’t forget to save your data after importing it. The program will automatically enter a value of 1 
if you leave a numeric value blank. 
 
You can print the data file by selecting the File, Print menu option. 

                                                      
#IDH_DBPUMP 
$Pump Database 
kData;Pumps;Files 



 
 



 



#$k  {bmc Pman.bmp}  Viscosity of Liquid - Slurries 
 

In the slurry context the viscosity of liquid refers to the viscosity of the carrier liquid. This is usually 
water. See Viscosity. 
 
For non Newtonian slurries such as Bingham slurries flowing in a pipe at velocities less than the 
Critical Velocity Vc, the slurry has an apparent viscosity which varies as the shear rate varies, so 
it is not possible to say what the viscosity of the slurry is without also specifying an accompanying 
shear rate. The Bingham friction loss formulae compensate for this behaviour so it is not a 
requirement that you enter a viscosity for the mixture, only enter the viscosity of the carrier liquid. 
When the flow becomes turbulent, the liquid no longer behaves like a plastic but reverts to a 
normal liquid characteristic and so the conventional Darcy friction loss formula is applied where 
the liquid viscosity affects the friction factor and thus the friction loss. Some slurries may have 
additives or constituents which modify the apparent viscosity. Consult your metallurgical 
laboratory for viscosity values to use which will most closely represent the actual slurry 
characteristics in the laminar and the turbulent flow regimes. 
 
Note : For both Heterogeneous and non-Heterogeneous slurries you may choose to use a carrier 
liquid viscosity higher than that of water. This will result in higher friction losses (in the turbulent 
flow regime for Bingham slurries and in all flow regimes for Heterogenous slurries) than if you 
used a viscosity of 1 cp (say). 
 
 

                                                      
# IDH_SLVISC 
$ Viscosity of Liquid - Slurries 
k Sl;SG of Liquid - Slurries 



#$k  {bmc Pman.bmp}  SG of Dry Solids 
 

In the slurry context this refers to the specific gravity of the solids material of the slurry. 

                                                      
# IDH_SLSGDRY 
$ SG of Dry Solids 
k SG of Dry Solids;S 



#$k  {bmc Pman.bmp} SG of Mixture - Sm 
 

In the slurry context this refers to the combined specific gravity of the solids material of the slurry 
and the carrier liquid. 
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 where : 
  Sm is the SG of Slurry Mixture 

  Sl is the SG of the Slurry Carrier Liquid 
  Cv is the concentration of solids in the slurry by true volume 
  S is the SG of the Dry Solids 

                                                      
# IDH_SLSM 
$ SG of Mixture - Sm 
k SG of Mixture;Sm 



#$k  {bmc Pman.bmp} Convert Tonnes / hr of Solids to Flow Rate 
 

Used to convert metric Tonnes per hour of Solid Material to a flow rate of the slurry mixture. 
The formula used is : 

 Q = 

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 +  1
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 where: 
  Q is the calculated flow rate of slurry mixture in litres per second 
  % Water is the percentage of water by mass in the mixture 
  % Solids is the percentage of Solids by mass in the mixture 
  Tonnes / hr is the number of metric tonnes per hour of solids to be transported 
  SG Solids is the specific gravity of the Solids material. 

                                                      
# IDH_SLTPH 
$ Convert Tonnes per hour to Flow rate  
k Tonnes/hr;Pulp Flow Rate;Solids to Flow Rate 



#$k  {bmc Pman.bmp} Concentration by Mass (Weight) - Cw 
 

In the slurry context this refers to the concentration of solids in the slurry expressed as a 
percentage by mass. 
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 where : 
  Cw is the concentration by mass in % 
  S is the SG of Slurry of the Dry Solids 
  Sl is the SG of the Slurry Carrier Liquid 
  Cv is the concentration of solids in the slurry by true volume 

                                                      
# IDH_SLCW 
$ Concentration by Mass - Cw 
k Concentration;by mass;Cw 
 



#$k  {bmc Pman.bmp} Concentration by Volume - Cv 
 

In the slurry context this refers to the concentration of solids in the slurry expressed as a 
percentage of the true volume occupied by the solids. 
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 where : 
  Cv is the concentration by volume in % 
  S is the SG of Slurry of the Dry Solids 
  Sl is the SG of the Slurry Carrier Liquid 
  Sm is the SG of the Mixture 

                                                      
# IDH_SLCV 
$ Concentration by Volume - Cv 
k Concentration by Volume;Cv 



#$k  {bmc Pman.bmp} Average Solids Size - d50 
 

In the slurry context this refers to the average size of the solids in mm. i.e. 50% of the solids 
would pass a screen of that size and 50% would be retained. 

                                                      
#IDH_SLD50 
$ Average Solids Size - d50 
k Average Solids Size;d50 



#$k  {bmc Pman.bmp} Yield Shear Stress - Bingham Slurry  
This is a Bingham Slurry Property which defines the Yield Shear Stress at which the slurry begins 
to flow. See Liquid Classification 

                                                      
#IDH_SLT 
$ Yield Shear Stress - Bingham Slurry (T) 
k Yield Shear Stress;Bingham Slurry;T 



#$k  {bmc Pman.bmp} Co-efficient of Rigidity (n) - Bingham Slurry  
 

This is a Bingham Slurry Property which is similar to the Viscosity property of a Newtonian Fluid. 
It denotes the slope of the Shear Stress vs Shear Rate diagram for the fluid. 
 

 T T n dv
dzo= +  

 where : 
  T is the shear stress 
  To is the Yield Shear Stress 
  n is the Co-efficient of Rigidity 
   
See Liquid Classification 
 

                                                      
#IDH_SLN 
$ Co-efficient of Rigidity(n 
k Co-efficient of Rigidity;n;Slurry n 



#$k  {bmc Pman.bmp} Pump Wear Factor Pw 
 

This is a pump performance correction factor which the user can enter to derate performance for 
future wear of the pump. It affects the Head that the pump produces at a given flow rate. For 
example if you enter 0.9 then the pump performance (head) is de-rated by the original database 
curve performance x 0.9 at any given flow rate. The pump efficiency is also de-rated accordingly. 
 

                                                      
#IDH_SLPW 
$ Pump Wear Factor Pw 
k Pump Wear Factor; Pw;Wear; 



#$k  {bmc Pman.bmp} Slurry Pump Performance Head Ratio - HR 
 

This is a pump performance correction factor which the program automatically calculates from 
de-ration charts built into the program. It depends on the slurry characteristics and is applied 
to the head and to the efficiency of the pump performance. The value of HR depends on the 
concentration of solids Cv, the SG of Dry Solids S, the SG of the mixture Sm and the average 
solid size d50. 

                                                      
#IDH_SLHR 
$ Slurry Pump Performance Factor HR 
k Slurry Pump Performance Factor; HR;Pump Deration 



#$k  {bmc Pman.bmp} Bingham Slurry 
 

A Bingham slurry is a homogenous slurry and usually consists of very fine particles. These are 
usually smaller than 0.1 mm. It is has unique properties in that it does not begin to flow until some 
finite Shear Stress is applied to it (called the Yield Shear Stress) and when it does begin to flow it 
moves a slug of liquid and this slug moving in pipe has a large surface area of contact with the 
pipe thus causing a relative large friction loss even at very small flow rates. 
 
The apparent viscosity of a Bingham Slurry varies with the Shear Rate : 
 

  
 the apparent viscosity’s at P1 and at P2, u1 and u2 are not equal. 
 
A Bingham slurry does not settle out its particles when it is at rest. It remains as a sort of gel. 
If the slurry you are dealing with displays the above characteristics, it is probably a Bingham type 
slurry. Click the Bingham Slurry Option Box to on and do not forget to enter the Yield Shear 
Stress and Co-efficient of Rigidity in order to calculate the system head losses 
Above Reynolds Numbers of about 2000 - 4000, the flow becomes turbulent and the normal 
Darcy-Weisbach friction loss formulae apply as there is no longer a slug of liquid moving in the 
pipe. 
 
Bingham Slurry Formulae: 
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 where : 
  R is the Reynolds Number 
  D is the pipe ID 
  V is the velocity of flow 
  To is the Yield Shear Stress 
  n is the Co-efficient of Rigidity of the Slurry 
 

When flow is laminar (i.e. R < 2000) then the friction factor is given by f
R

=
64

 

but from Darcy 

                                                      
# IDH_SLBINGHAM 
$ Bingham Slurry 
k Bingham;Homogeneous Slurry 
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The critical velocity Vc is the velocity at which flow becomes turbulent i.e. R > 4000 and is given 
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The Friction Loss can thus be expressed as : 
 

  H LT
g D

nLV
g Df

o=






 +









16
3

32
2ρ ρ  

 

 
 
See Liquid Classification 



#$k Widely Graded / Closely Graded Slurry 
 

A Widely Graded Slurry is classed as one where the ratio of the particle sizes exceeds a ratio of 
2:1 for at least 90% by mass of the total mass of solids. If the above condition is not true then a 
slurry is considered to be Closely Graded. This characteristic affects the so called Froude shape 
factor and in turn has an effect on the limiting settling velocity of the slurry. 

See Durand’s Formula for the settling velocity calculation. 

                                                      
# IDH_SLWIDELY 
$ Bingham Slurry 
k Bingham;Homogeneous Slurry 



#$k Slurry Settling Velocity - Vl 
 

Heterogeneous slurries are classed as slurries in which the solid particles settle out of 
suspension when the slurry is at rest. They may Widely or Closely Graded and are called 
heterogeneous (or sand) slurries because they separate into the carrier liquid and solid particles. 
 
The velocity of flow below which a sand slurry begins to deposit its solid particles whilst moving in 
a pipe is known as the Limiting Settling Velocity, Vl. 
Durand’s Formula is used in this program to predict this limiting settling velocity, and is given 
below: 
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 where : 
  Vl is the Limiting Settling Velocity 
  Fl is the Froude Factor obtained from experimental charts 
  g is the gravitational acceleration constant 
  D is the pipe internal diameter 
  Sl is the SG of Carrier Liquid 
  S is the SG of Dry Solids 
 
At velocities below the Limiting Velocity, the settlement of solid particles reduces the cross-
sectional area available for the liquid to flow and this in turn increases the friction losses. 
 
 

 
Note : The minimum head on the slurry system curve is reached at a velocity of approximately 
0.7 x Vl, and at a flow rate equating to 1.3 x Vl, the system head generally follows that of the 
carrier liquid which is usually water. 
 

                                                      
# IDH_SLVL 
$ Slurry Settling Velocity, Vl 
k Slurry Settling Velocity;Heterogeneous Slurry;Vl;Blockage;Slurry System Head 



 



#$k  {bmc Pman.bmp}  Ideal Gas Laws 

 
Boyles Law 
The volume of a gas, at constant temperature, varies inversely with pressure 

PV P V1 1 2 2= = Constant  

 

Charles’ Law 
At constant pressure the volume of a gas varies directly with the absolute temperature 
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Amonton’s Law 
The pressure of a gas, at constant volume, varies directly with the absolute temperature 
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Avogadro’s Law 
All gasses subjected to the same conditions of pressure, volume and temperature, contain the 
same number of molecules. For example, one gram mole of oxygen, mass 32 grams, 
contains 6.02x10^23 molecules and has a volume of 22.4 litres at standard temperature and 
pressure. 

 

General Gas Law 
By combining the above laws 

 

PV mRT=    and  R R
M

u

w

=  

where P is the absolute pressure in Pa 
 V is the volume in m3 
 m is the mass of the gas in kg 
 R is the individual gas constant in J/kg-K 
 Ru is the universal gas constant = 8314 
 Mw is the molecular weight of the gas 

For air, Mw = 28.96 and 

R = 8314/28.96 = 287.1 

 
 
 

                                                      
#IDH_GLAWS 
$Gas Laws 
kGasses;Gas Laws;Gas Constant 



#$k  {bmc Pman.bmp}  Isothermal Gas Flow 

Isothermal gas flow occurs in relatively long gas pipelines where the heat transfer to the 
surroundings is sufficient to maintain constant temperature.  
 
The pressure drop equation is given as : 
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where  
 G = mass flow rate in kg/m2 = w/A 
 P = the beginning and end pressures 
 R = gas constant 
 T = absolute temperature in deg Kelvin 
 Mw = molecular weight 
 f = Darcy friction factor 
 L = pipe length in m 
 D = pipe diameter in m 
 
Isothermal conditions can only be maintained when flow velocity and pressure drop are kept 
below certain levels. If pressure drop is high then velocity may increase until it reaches the 
local speed of sound, at which point flow becomes choked and sonic velocities occur. At this 
point flow conditions can no longer be regarded as isothermal and the Modified Darcy method 
of calculation should be used. 
 
This program indicates a choked flow condition graphically in the network sketch by drawing a 
filled circle on the pipe just downstream of the arrow head if the flow is choked. 
 
Choked Flow 

 
 
Free Flow 

 
 
Refer to Perry’s Chemical Engineers Handbook for more details. 
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#$k  {bmc Pman.bmp}  Modified Darcy Method 

The rate of flow of a gas from a high pressure area to a low pressure area reaches a 
maximum at a certain pressure differential and will not increase above this flow rate even if 
the upstream pressure is increased. This condition is known as a choked flow condition - the 
velocity of flow has reached the speed of sound in the fluid, also known as a sonic flow 
condition. 
 
The Modified Darcy method of calculation checks for this choked flow condition and if 
necessary reduces the flow rate by a factor also called the net expansion factor. This factor 
depends on the gas characteristics and in this program the ratio of the specific heat capacities 
and the pressure drop ratio are used to calculate the expansion factor, and reduce the flow 
rate where required. 
 
A typical formula used is: 
 
sonic velocity  V s R T= γ  
 
where γ  is the ratio of the specific heat capacities of the gas = Cp/Cv 
 R is the gas constant 
 T is the absolute temperature in deg K 
 
 

also  w Xd p
KV

= 2

1

∆
 

 
where X is the net expansion factor multiplied by a unit constant 
 w is the mass flow rate in kg/s  
 d is the pipe diameter in mm 
 P is the pressure drop 
 K is the total pipe and fitting shock loss co-efficient 
 V is the specific volume of the gas in m3/kg 
 
 
Choked Flow 

 
 
Free Flow 
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